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About Office
Word 2016 is part of the Microsoft Office 2016 suite of apps, which also includes Microsoft Access, Excel, Outlook, and PowerPoint. The apps in the Office suite are designed to work together to provide highly efficient methods of getting things done. You can one or more Office apps on your computer. Some apps have multiple versions designed for different platforms. For example, you can install different versions of Word on a computer, a smartphone, an iPad, and an Android device; you can also work in a version of Word that is hosted entirely online. Although the core purpose of an app remains the same regardless of the platform on which it runs, the available functionality and the way you interact with the app might be different.
Start Word
The way that you start Word 2016 is dependent on the operating system you are
running on your computer. For example:
· In Windows 10, you can start Word from the Start menu, the All Apps menu, the Start screen, or the taskbar search box.

1. Click the Start button, and then click All apps.
2. In the app list, click any index letter to display the alphabet index, and
then click W to scroll the app list to the apps starting with that letter.
3. Scroll the list if necessary, and then click Word 2016 to start the app.

· In Windows 8, you can start Word from the Apps screen or Start screen search results.

1. From the Start screen, display the Apps screen.
2. Sort the Apps screen by name, and then click any index letter to display
the alphabet index.
3. In the alphabet index, click W to scroll the app list to the apps starting
with that letter. Then click Word 2016 to start the app.

· In Windows 7, you can start Word from the Start menu, All Programs menu, or Start menu search results.
· You might also have a shortcut to Word on your desktop or on the Windows taskbar.

When you start Word without opening a specific document, the Word Start screen appears. The Start screen is a hybrid of the Open and New pages of the Backstage view. It displays links to recent files in the left pane, and new file templates in the right pane.

To start Word by opening a document
1. Do either of the following:
· In File Explorer, double-click the document.
· In Microsoft Outlook, double-click a document that is attached to an email message.

Microsoft Word is developed to do the following:
· Create professional-looking documents that incorporate impressive graphics.
· Give documents a consistent look by applying styles and themes that control the font, size, color, and effects of text and the page background.
· Store and reuse preformatted elements such as cover pages and sidebars.
· Create personalized mailings to multiple recipients without repetitive typing.
· Track reference information and compile tables of contents, indexes, and bibliographies. Coauthor documents with team members. 
· Safeguard documents by controlling who can make changes and the types of changes that can be made, and by removing personal and confidential information.
· When you’re working with a document, it is displayed in an app window that contains all the tools you need to add and format content.
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Identify app window elements
The Word app window contains the elements described in this section. Commands for tasks you perform often are readily available, and even those you might use infrequently are easy to find.


1- Title bar
At the top of the app window, this bar displays the name of the active file, identifies the app, and provides tools for managing the app window, ribbon, and content.
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The Quick Access Toolbar at the left end of the title bar can be customized to include any commands that you want to have easily available. The default Quick Access Toolbar in the Word app window displays the Save, Undo, and Redo/Repeat buttons. You can change the location of the Quick Access Toolbar and customize it to include any command to which you want to have easy access.

2- Ribbon
The ribbon is located below the title bar. The commands you’ll use when working with a document are gathered together in this central location for efficiency.
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TIP:
The available ribbon tabs and the appearance of commands on the ribbon might differ from what is shown in this book, based on the apps that are installed on your computer, the Word settings and window size, and the screen settings.

Across the top of the ribbon is a set of tabs. Clicking a tab displays an associated set of commands arranged in groups.

Commands related to managing Word and documents (rather than document content) are gathered together in the Backstage view, which you display by clicking the File tab located at the left end of the ribbon. Commands available in the Backstage view are organized on named pages, which you display by clicking the page tabs in the colored left pane. You redisplay the document and the ribbon by clicking the Back arrow located above the page tabs.
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On each tab, buttons representing commands are organized into named groups. You can point to any button to display a ScreenTip that contains the command name, a description of its function, and its keyboard shortcut (if it has one). The ScreenTips can include the command name, keyboard shortcut, and description[image: ]
Some buttons include an arrow, which might be integrated with or separate from the button. To determine whether a button and its arrow are integrated, point to the button to activate it. [image: ]
Tell me what you want to do
Entering a term in the Tell Me What You Want To Do box located to the right of the ribbon tabs displays a list of related commands and links to additional resources online. Or you can press F1 to open the Help window for the current app.
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3. Status bar
Across the bottom of the app window, the status bar displays information about the current document and provides access to certain Word functions. You can choose which statistics and tools appear on the status bar. Some items, such as Document Updates Available, appear on the status bar only when that condition is true.
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The View Shortcuts toolbar, Zoom Slider tool, and Zoom button are at the right
end of the status bar. These tools provide you with convenient methods for
changing the display of document content.
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Work with the ribbon and status bar
The goal of the ribbon is to make working with document content as intuitive as possible. The ribbon is dynamic, meaning that as its width changes, its buttons adapt to the available space. As a result, a button might be large or small, it might or might not have a label, or it might even change to an entry in a list. For example, when sufficient horizontal space is available, the buttons on the References tab of the Word app window are spread out, and you can review the commands available in each group.
[image: ]
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When the ribbon becomes too narrow to display all the groups, a scroll arrow
appears at its right end. Clicking the scroll arrow displays the hidden groups.[image: ]
The width of the ribbon depends on these three factors:
1- Window width Maximizing the app window provides the most space for the ribbon.

2- Screen resolution Screen resolution is the size of your screen display expressed as pixels wide × pixels high. The greater the screen resolution, the greater the amount of information that will fit on one screen. Your screen resolution options are dependent on the display adapter installed in your computer, and on your monitor. Common screen resolutions range from 800 × 600 to 2560 × 1440 (and some are larger). The greater the number of pixels wide (the first number), the greater the number of buttons that can be shown on the ribbon.

3- The magnification of your screen display If you change the screen magnification setting in Windows, text and user interface elements are larger and therefore more legible, but fewer elements fit on the screen.

You can hide the ribbon completely if you don’t need access to any of its buttons, or hide it so that only its tabs are visible. (This is a good way to gain vertical space when working on a smaller screen.) Then you can temporarily redisplay the ribbon to click a button, or permanently redisplay it if you need to click several buttons.

To maximize the app window
1. Do any of the following:
• Click the Maximize button.
• Double-click the title bar.
• Drag the borders of a non-maximized window.
• Drag the window to the top of the screen. (When the pointer touches the
top of the screen, the dragged window maximizes.)

To change the screen resolution
1. Do any of the following:
• Right-click the Windows 10 desktop, and then click Display settings. At the bottom of the Display pane of the Settings window, click the Advanced display settings link.
• Right-click the Windows 8 or Windows 7 desktop, and then click Screen resolution.
• Enter screen resolution in Windows Search, and then click Change the
screen resolution in the search results.
• Open the Display Control Panel item, and then click Adjust resolution.

2. Click or drag to select the screen resolution you want, and then click Apply or OK. Windows displays a preview of the selected screen resolution.
3. If you like the change, click Keep changes in the message box that appears. If you don’t, the screen resolution reverts to the previous setting.

To completely hide the ribbon
1. Near the right end of the title bar, click the Ribbon Display Options button.
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2. On the Ribbon Display Options menu, click Auto-hide Ribbon.





To permanently redisplay the ribbon
1. Do any of the following:
· Double-click any tab name.
·  Near the upper-right corner of the app window, click the Ribbon Display Options button, and then click Show Tabs and Commands.
· Press Ctrl+F1.

To temporarily redisplay the ribbon
1. Click any tab name to display the tab until you click a command or click away from the ribbon.
To specify the items that appear on the status bar
1. Right-click the status bar to display the Customize Status Bar menu. A check mark indicates each item that is currently enabled.
2. Click to enable or disable a status bar indicator or tool. The change is effected immediately. The menu remains open to permit multiple selections.
3. When you finish, click away from the menu to close it.

Manage Office and app settings
You access app settings from the Backstage view; specifically, from the Account page and the Word Options dialog box.
The Account page of the Backstage view in Word displays information about your installation of Word (and other apps in the Office suite) and the resources you connect to. This information includes:
· Your Microsoft account and links to manage it.
· The current app window background and theme.
· Storage locations and services (such as Facebook and LinkedIn) that you’ve connected Office to.
· Your subscription information and links to manage the subscription, if you have Office through an Office 365 subscription.
· The app version number and update options.
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Microsoft account options If you use Office 365, Skype, OneDrive, Xbox Live, Outlook.com, or a Windows Phone, you already have a Microsoft account. (Microsoft account credentials are also used by many non-Microsoft products and websites.) If you don’t already have a Microsoft account, you can register any existing account as a Microsoft account, you can register any existing account as a Microsoft account, sign up for a free Outlook.com or Hotmail.com account and register that as a Microsoft account.

To display your Office account settings
1. With Word running, click the File tab to display the Backstage view.
2. In the left pane of the Backstage view, click Account.

To manage your Microsoft account settings
1. Display the Account page of the Backstage view.
2. In the User Information area, click any of the links to begin the selected process.

To change the app window background for all Office apps

1. Display the Account page of the Backstage view.
2. In the Office Background list, point to any background to display a live preview in the app window, and then click the background you want. 

To change the app window color scheme for all Office apps

1. Display the Account page of the Backstage view.
2. In the Office Theme list, click Colorful, Dark Gray, or White.

To connect to a cloud storage location or social media service
1. Display the Account page of the Backstage view.
2. At the bottom of the Connected Services area, click Add a service, click the type of service you want to add, and then click the specific service.
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To manage your Office 365 subscription
1. Display the Account page of the Backstage view.
2. In the Product Information area, click the Manage Account button to display the sign-in page for your Office 365 management interface.
3. Provide your account credentials and sign in to access your options.







To manage Office updates
1. Display the Account page of the Backstage view.
2. Click the Update Options button, and then click the action you want to take.
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To open the Word Options dialog box
1. In the left pane of the Backstage view, click Account.

Practice Tasks:
A) Start Word
Perform the following tasks:
1. Using the technique that is appropriate for your operating system, start Word.
2. When the Start screen appears, press the Esc key to create a new blank document.

B) Work in the Word user interface
Start Word, create a new blank document, maximize the app window, and then perform the following tasks:
1. On each tab of the ribbon, do the following:
· Review the available groups and commands.
·  Display the ScreenTip of any command you’re not familiar with. Notice the different levels of detail in the ScreenTips.
·  If a group has a dialog box launcher in its lower-right corner, click the dialog box launcher to display the associated dialog box or pane.
2. Change the width of the app window and notice the effect it has on the
ribbon. When the window is narrow, locate a group button and click it to display the commands.
3. Maximize the app window. Hide the ribbon entirely, and notice the change in the app window. Redisplay the ribbon tabs (but not the commands). Temporarily display the ribbon commands, and then click away from the ribbon to close it.
4. Use any of the procedures described in this chapter to permanently redisplay the ribbon tabs and commands.
5. Display the status bar shortcut menu, and identify the tools and statistics that are currently displayed on the status bar. Add any indicators to the status bar that will be useful to you.
6. Keep the document open in Word for use in the next set of practice tasks.

C) Manage Office and app settings
With a new blank document open in Word, perform the following tasks:
1. Display the Account page of the Backstage view and review the
information that is available there.
2. Expand the Office Background list. Point to each theme to display a live
preview of it. Then click the theme you want to apply.
3. Apply each of the Office themes, and consider its merits. Then apply the theme you like best.
4. Review the services that Office is currently connected to. Expand the Add a service menu and point to each of the menu items to display the available services. Connect to any of these that you want to use.
5. Click the Update Options button and note whether updates are currently available to install.
6. On the Update Options menu, click View Updates to display the What’s New and Improved in Office 2016 webpage in your default browser. Review the information on this page to learn about any new features that interest you.
7. Return to Word, and open the Word Options dialog box.
8. Explore each page of the dialog box. Notice the sections and the settings in each section. Note the settings that apply only to the current file.
9. Review the settings on the General page, and modify them as necessary to fit the way you work. Then close the dialog box.
10. Close the document without saving changes.
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